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by Ted Wirtz

“My First Look At Windows 8” is the subject 
of my presentation on March 12. As I wrote 

in the last newsletter, I recently purchased a laptop 
computer that came with Windows 8 preinstalled. 
It was my first laptop, as I’ve always used a desktop 
before now.

I had seen some earlier reviews of Windows 
8 (Win8) and I was put off by the “Modern” user 
interface that Microsoft had implemented in Win8. 
I wanted to install Win 7 in order to have an OS that 
was familiar to me. The Win7 disks I had purchased 
some time ago were upgrade disks, and would not 
allow me to “downgrade” from Win8 to Win7. Good 
thing too, as I found out later that the laptop I had 
purchased had been designed specifically for Win8. 

Drivers for Win7 are not available for this particu-
lar machine.

So…I guess I had to get familiar with Win8. 
One of the differences that rankled me was that 
there was no “Start” button. (I solved that by in-
stalling Start 8. See page 22 of the February news-
letter for a complete description of the program.) 
Win8’s “Start menu” is also completely different 
than prior versions of Windows. I would have to 
get used to that interface as well. 

Over the past few weeks I’ve learned quite a bit 
about the system. So come to the March meeting 
and I’ll show you what I know about Win8 so far. 
I’m still learning, so I’m not an expert. After the 
presentation we’ll have a Q and A and during that 
session we will probably learn more together.

my first look at windows 8
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feedback
Carl Westberg
ORCOPUG, CA

Being appalled by the learning 
curve and cost of Windows, I 

am trying to keep XP running as 
long as possible. 

Do you have any comments 
on ReImage, which supposedly 
restores one’s system, providing 
files as necessary. It seems like a 
good idea to have a “warehouse” 
of files that can be called on, but, 
does it work? 

On the hardware side —how 
does one replace a hard drive 
while still maintaining the 
multiple drive ability with the 
unavailability of PATA hard drives. 
The adapters appear to convert to 
SATA cables at the motherboard 
rather than converting at the drive. 
The optical drives are functional, 
but I fear for the life of the HDDs. 
Experience has meant caution, 
always have a replacement.

Thanks for any help you can 
give.

Tony Lake
Utah

In her final days as Commander 
of the International Space Sta-

tion, Sunita Williams of NASA 
recorded an extensive tour of the 
orbital laboratory and downlinked 
the video on Nov. 18, just hours 
before she headed back to Earth. 

The tour includes scenes the 
station’s modules and research 
facilities with Williams’ running 
narrative of the work which 
is ongoing aboard the orbital 
outpost. http://www.youtube.com/
watch?v=doN4t5NKW-k

Neil Longmuir
WPCUSRGRP, Canada

Here are two even better ex-
planations of RAW formats. 

The explanation on photo.net is 
great. http://photo.net/learn/raw/ 
and http://www.luminous-land-
scape.com/tutorials/understand-
ing-series/u-raw-files.shtml

(The first explanation Neil sent 
is on page 16. —LG)

Ron Hirsch
Florida

Apparently the Hedy Lamarr 
story is making the rounds 

these days, as I see it in your cur-
rent newsletter. I had heard of this 
back many years.

In November 1973, Sally and 
I were on a trip to the Caribbean, 
and we were in St. Maarten. While 

I was walking on the beach with 
my camera, I came across the 
person below. I had heard that she 
was at this hotel, and I instantly 
recognized her as Hedy Lamarr. 
She was still slim, but of course 
she had aged. And there were 
many signs of plastic surgery. In 
the evening, she would dress up, 
keeping most of her body under 
clothing, and she would frequent 
the main bar at the hotel, to 
“pickup” male companions.

 I approached her, and 
asked if I might take some 
pictures of her (I always had 
my camera with me). She said 
yes, and commented that in her 
day, taking her picture was an 
expensive proposition. But she 
allowed me to do so. 

I took about half a dozen shots, 
and this one is the best. This was 
40 years ago, and of course, she is 
no longer among us.

Hedy 
Lamarr

Mike Lyons, president
ORCOPUG, CA

If you are interested in security 
notifications, I follow this site 

(recommended by Steve Gibson) 
https://krebsonsecurity.com. He 
seems to get security news out 
sooner than anyone else and 
doesn’t overload you with useless 
stuff. 
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Photo by Frank Bollinger, ORCOPUG

The plane is performing a tumbling aerobatic maneuver at the Wings over Camarillo air show 
on August 19, 2012. “The pilot  (called Tumbling Bear) was supposed to retire last year, but I’ve 

heard he will be at several air shows this year,” Frank said. He took the photo using a Canon EOS 
REBEL T1i.
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WORDdisplaying actual font faces

Copyright © 2012 by Sharon Parq Associates, Inc. Reprinted by permission.  Thousands of free Microsoft Word tips can be found online at http://word.tips.net

by Allen Wyatt

When you are applying format-
ting to various parts of your 
document, you may find it 

useful to actually see a sample of a font 
before you apply it. For instance, the 
drop-down font list on the Formatting 
toolbar can be very handy if the fonts 
names are displayed using the representa-
tive typeface, rather than just a simple 
listing of typeface names.

Beginning with Word 2000 you can 
control whether Word uses typefaces to 
show font names. You do this by following 
these steps:

1.  Choose Customize from the Tools 
menu. Word displays the Customize 
dialog box.

2.  Make sure the Options tab is se-
lected. (See Figure 1.)

3.  Ensure the List Font Names in 
Their Font check box is checked.

4.  Click on OK.
If you check out the font drop-down list, you 

will notice that it now uses the various typefaces to 
display font names.

Remember that this feature is only available 
beginning with Word 2000. Regardless of the ver-
sion of Word you are using, you can always use the 
Font dialog box to display what a font will look like. 
Simply select the text you want to format and then 

Figure 1. The Options tab of the Customize dialog box.

press Ctrl+D. The font dialog box is displayed, with 
the selected text appearing as the sample at the bot-
tom of the dialog box. As you select different fonts in 
the dialog box you can easily see the effect it has on 
the selected text.

This tip applies to Microsoft Word versions: 97, 
2000, 2002 and 2003 and is at http://word.tips.net/
T001550_Displaying_Actual_Font_Faces.html
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new google+

Copyright © 2012 by Sharon Parq Associates, Inc. Reprinted by permission. Thousands of free Microsoft Excel tips can be found online at http://excel.tips.net

EXCELchanging gridline color

by Allen Wyatt

The gridlines help you track in-
formation on the screen easier 
and to locate cells quickly. 

Normally the gridlines are shown in 
black, but you may want to make them 
some other stylish color. 

If you want to change the gridline 
color, follow these steps if you are using 
Excel 2007:

1.  Click the Office button and 
then click Excel Options. Excel dis-
plays the Excel Options dialog box.

2.  At the left of the dialog box click 
Advanced.

3.  Scroll through the options until 
you see the Show Gridlines check box; 
select it.

4.  Click the Gridline Color con-
trol and choose a color you want to 
use for the gridlines.

5.  Make sure the Show Gridlines check box is 
selected.

6.  Click on OK.

If you are using an older version of Excel, follow 
these steps instead:

1.  Choose Options from the Tools menu. You 
will see the Options dialog box.

2.  Click on the View tab.
3.  Use the Color drop-down palette to select a 

color for your gridlines.
4.  Make sure the Gridlines check box is se-

lected.
5.  Click on OK.
You can specify different gridline colors for each 

worksheet in a workbook.

This tip applies to Microsoft Excel versions: 97, 
2000, 2002, 2003 and 2007 and is at http://excel.tips.
net/T002736_Changing_Gridline_Color.html
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QUESTION: I need to buy an external hard drive. 
I’ve been looking at Western Digital and Seagate. 
What do you recommend and what files should I 

back up?

ANSWER: When I recommend WD highly and have 
many of them. The 1TB will do for all your needs and you 
do not need an extra program, it is all in the one unit. This 
one is password protected, which I recommend; I have the 
same one and love it! Remember to disconnect the external 
drive when you have completed your backup! Put it in a 
safe place ready for your next backup. This is very impor-
tant to remember. It is also important to remember not to 
disconnect your external hard drive while your computer 
is on. Wait until you turn your computer off at night and 
then disconnect your external hard drive or use the “Safely 
Remove” icon.

QUESTION: Can you tell me how to log off of SkyDrive?

ANSWER: It seems you won’t be able to logout from the 
SkyDrive in Photo app. Once logged in using your Win-

by Pamela Tabak

I cannot send or 
delete emails in 
Microsoft Outlook. 
My internet 
connection is 
working and my 
Internet Provider 
says that I need 
to “compact” 
Outlook. Why this 
is happening?
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Send your 
computer-based 

questions to Pamela 
Tabak, pamela@

computertutorinc.
net or visit www.

computertutorinc.net 
for answers.

dows Live account, you will be al-
ways connected to SkyDrive like the 
other apps which use the Windows 
Live account.

QUESTION: Why can’t I open your 
Tutorials? It says that I do not have 
the program. What program do I 
need?

ANSWER: To read my tutorials you 
will need Adobe Reader X. If you 
have a previous version you may not 
be able to open the files. To be sure 
you have the correct version go to 
your program list and click on Adobe 
Reader if it is on the list. Then click 
on the “help’ file and scroll down 
and click on “Check for updates.” 
If you do not have the program visit 
the following link and download the 
latest FREE version: http://get.adobe.
com/reader/

QUESTION: Would you please 
publish a list of ALT codes?

ANSWER: Below are the most popu-
lar ALT codes. If you need additional 
ALT codes please contact me. Make 
sure your “numlock” is active, hold 
down the ALT key and type the num-
bers on the numeric keyboard.

QUESTION: I cannot send or delete 
emails in Microsoft Outlook. My 
internet connection is working and 
my ISP (Internet Provider) says that I 
need to “compact” Outlook. Can you 
please give me detailed instructions 
and tell me why this is happening?

ANSWER: All of your email is stored 
in a Personal Folders file (.pst), if 
you are using Microsoft Outlook 
or Outlook Express, which tends to 
build up in size over time. This can 
cause MO or OE to malfunction or 
“overload” if not “compacted.” It can 
also cause emails to get stuck in the 
“outbox” and even refuse to delete. 
To avoid this, regain some hard 
drive space and speed up Outlook 
you should “compact” the “pst” file 
regularly. Follow the steps below for 
your version:

Microsoft Office Outlook 2010
1. Delete any items that you do 

not want to keep, and then empty the 
Deleted Items folder.

2. Click the File tab on the Rib-
bon, and then click the Info tab on 
the menu.

3. Click the Accounts Settings tab, 
and then click on Accounts Settings 
again

4. Click the Data Files tab.
5. Click to select your Personal 

folder, and then click Settings.
6. On the General tab, click 

Compact Now.
7. Click OK, and then click 

Close.

Microsoft Office Outlook 2007
1. Delete any items that you do 

not want to keep, and then empty 
the Deleted Items folder.

2. On the Tools menu, click Ac-
count Settings.

3. In the list, select Microsoft 
Exchange Server, and then click 
Change.

4. Click More Settings.
5. On the Advanced tab, click 

Offline Folder File Settings.
6. Click Compact Now.

Microsoft Office Outlook 2003 
and earlier versions

1. On the Tools menu, click to 
select E-mail Accounts.

2. Click View or change exist-
ing e-mail account, and then click 
Next.

3. Click Microsoft Exchange 
Server, and then click Change.

4. Click More Settings.
5. On the Advanced tab, click 

Offline Folder File Settings.
6. Click Compact Now.
7. When the compact operation 

is finished, click OK twice.
8. Click Next, and then click 

Finish.

To use an 
ALT code, 
hold down 
the ALT key 
and type the 
numbers on 
the numeric 
keyboard.

COMPUTER HELP
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Sadly, this is all too common. 
Malware is getting pretty nasty. 
At best it may extort money 

from you for a real repair — at worst 
it’ll extort money from you and do 
nothing.

I’ll save the “prevention is so 
much easier than the cure” missive 
for another day. We just want this 
fixed.

I am trying to fix a computer that 
is running XP Pro. It has adware 
that is preventing me from getting 
into regedit and Task Manager. 
It will not let me boot into Safe 
Mode. It will not let me install any 
antispyware or antivirus software. 
Not sure where to go from here. It 
has stopped me from doing much of 
anything to get the malware off the 
computer. Any suggestions? I am not 
sure what the malware is but I think 
it’s Antispyware 2010 or something 
like that. I keep getting alerts that I 
am infected and when I click one, a 
browser window opens and tries to 
take me to a website.

COMPUTER HELP

how do I remove 
a virus if it 
prevents me 
from download 
or installing 
anything?

ask leo!
            by Leo A. Notenboom

There are things we can try, but 
there are no guarantees.

the problem: malware 
interferes

The problem that you’re seeing 
is that the malware on the machine 
is actively looking for you to try to 
remove it.

It’s watching for downloads that 
“look like” anti-malware tools, and it’s 
watching for web or other access that 
might be going to anti-malware sites. 
It’s even monitoring what programs 
you run. When it sees you doing 
that (or other things that could lead 
to its removal) it steps in and either 
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redirects you to sites of its choosing, or simply causes the 
operation to fail.

We’d love to download and run anti-malware tools, but 
we can’t.

temporarily kill the malware
One possible solution to the blocking problem is to 

temporarily kill the malware that’s running. This won’t 
remove it, but may allow you to download tools that will.

The folks at BeepingComputer.com have created a 
tool called RKill (be careful: at this writing there’s an ad 
immediately above the download link that looks like the 
download link. It is not. Be sure to grab RKill itself).

You may need to download RKill on another machine 
(because of course it may well be blocked on the infected 
machine), but you can quickly copy it over using a USB 
drive or something else.

You may also need to rename RKill.exe to something 
else (like “notrkill.exe” or “leo.exe” or something else). 
Once again, the malware may be paying attention to the 
name of every program being run, and may prevent the 
software from running if it recognizes the name.

Run the program and do not reboot. Rebooting will 
“undo” the effect of having run RKill, and any malware 
that RKill killed will be back.

download and run malwarebytes’  
anti-malware

Malwarebytes’ Anti-Malware is currently one of the 
most successful tools at identifying and removing the 
types of malware we’re talking about here. It’s not really 
a replacement for anti-virus software (you’ll find them 
saying so in their support forums), but particularly in cases 
of infection it has a pretty darn good track record.

Download the free version, install it and run it and see 
what it turns up. (You may need or just want to download 
on the other machine and copy the download over as you 
did rkill.)

try other tools
After running RKill you may, or may not, be able to 

run some of the other tools that the malware was blocking. 
You can try registry editing tools, the task manager, process 
explorer or others.

You can also try your other anti-virus and anti-
spyware tools as well — perhaps they’ll be able to 
download an update that catches this problem, or 
perhaps you can download a new tool that will.

But in general my money’s on Malwarebytes.

what if it doesn’t work?
If none of that works, things get complicated.
There are a couple of things you can consider 

trying:
Boot from a bootable antivirus rescue CD. There 

are several, including from anti-virus vendors like 
Avira, AVG and several others. If you have a favorite 
anti-malware vendor, check with them to see if they 
provide a bootable scanning solution.

The reason that these are interesting is that they 
boot from the CD, not your hard drive, so the malware 

The malware may be paying attention 
to the name of every program being 
run, and may prevent the software from 
running if it recognizes the name.
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Used with permission of 
Leo A. Notenboom, Ask 
Leo! http://ask-leo.com. 
After retiring from Microsoft 
in 2001, Leo started Ask 
Leo! in 2003 as a place 
for answers to common 
computer and technical 
questions. 

COMPUTER HELP

doesn’t have a chance to operate and block you. You can 
then run a scan of your hard disk and hopefully clean it off.

Remove the hard disk and place it in or connect it to 
another machine. Hardware issues aside, this needs to be 
done with care to prevent the malware from spreading, 
but just like booting from that CD this boots from the new 
machine’s installation, not yours. You can then run anti-
malware tools against your drive and, hopefully, clean it 
off.

In other words, you know it was infected, but there’s 
no way to know that it’s not now.

Scary, eh?
The only way to know with absolute certainty that 

malware has been removed is to reformat your machine 
and reinstall everything from scratch.

Sadly, it’s also quite often the most pragmatic 
approach to removing particularly stubborn malware. 
Sometimes all the machinations we go through trying to 
clean up from a malware infection end up taking more 
time than simply reformatting and reinstalling.

And reformatting and reinstalling is the only 
approach that’s known to have a 100% success rate at 
malware removal.

If you don’t have a backup of your data then before 
you reformat at least copy the data off somehow. Boot 
from a Linux Live CD if you have to (Ubuntu’s a good 
choice) - that’ll give you access to all the files on your 
machine and allow you to copy them to a USB device or 
perhaps even upload them somewhere on the internet.

aftermath
After things are cleared up and working once again, 

take a few moments to consider how to prevent it from 
happening again, or what you can do to make the next 
time easier:

•  See if you can identify how the infection occurred, 
and to the extent that you can: never do that again. 

•  Make sure you have all the up to date security 
measures that it takes to stay safe on the internet.

•  Consider investing in a backup solution of some 
sort. Nothing can save you from more different kinds of 
problems than a good, regular backup.

As I said at the beginning — prevention is much 
easier than the cure.

Once your machine 
is infected it’s no 

longer yours. 

restore from backup
If you have a recent system backup it’s possible that 

restoring to that will take your machine back to a time 
before it was infected.

Regular backups are wonderful for this.
But beware, that they do have to be the correct type of 

backup: full system backups. Simply backing up your data, 
while better than not backing up at all, will not be helpful 
in a scenario like this.

And for the record, System Restore is pretty useless 
when it comes to bad malware infections like this (if it 
hasn’t already been completely disabled by the malware, of 
course).

the final solution
It sounds dire, because it is.
As I’ve mentioned before, once your machine is 

infected it’s no longer yours. You have no idea what’s been 
done to it. And you also have no idea whether or not any or 
all of the cleaning steps you took removed any or all of the 
malware that was on the machine.
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PHOTOGRAPHY BOOK REVIEW

by Neil Longmuir, WPCUSRGRP

Do you really want to know how to make 
complex selections? This book is all 
about “unlocking the key to perfect 

selections & amazing Photoshop effects for totally 
realistic composites.” This book is all about 
selections details and all the other details required 
to make a realistic composite.

Let me give you an example. You are give 
a job to do an advertising composite for a local 
company. To start with not all the elements of 
the composite are going to be available to you, 
the photographer at the same time. The elements 
could be an individual who may only be available 
for a photo shot in a studio or on location. A 
second element such as a billboard or company 
logo etc. could be supplied by the company whom 
the photo shot is for. That second element could 
also not be supplied by the company that you are working for 
and instead the company says find an interesting element to 
work for us. There could also be other elements such as text and 
special effects that may be required.

To start with, you photograph this individual in a studio 
location using a neutral background so that you can select the 
individual later to include in the composite. What do you have 
to do to make this work? 

First of all I would record all the setup in a notebook, smart 
phone or laptop. I would measure the exact distance from the 
background to the subject. I would measure the exact distance 
and high of the camera from the camera to the subject. Better 
yet, I would use a second camera to take a image of the setup 
I was shooting which would include the lighting. One further 
detail to note would be the shadow of a shoe in the image. Why? 
This shadow will have to look realistic in the composite image.

Next on the agenda is a background to place the subject you 
photographed in the studio. Given, what the company wants for 
it’s advertising, you must now search out a suitable background. 
Suppose, you found an old wall of a building that you feel would 
work great for the final product. Here’s where that notebook 
comes in handy because the wall has to be taken from exactly 
the same position and height as the picture taken in the studio. 

book review

Photoshop Compositing Secrets: 
Unlocking the Key to Perfect Selections 

and Amazing Photoshop Effects for 
Totally Realistic Composites 

by Matt Kloskowski

Paperback: 408 pages
Publisher: Peachpit Press
1 edition (August 8, 2011)

ISBN-10: 0321808231
ISBN-13: 978-0321808233

$39.99 

(35% Discount for UG Members)
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PHOTOGRAPHY BOOK REVIEW

Matt Kloskowski is a Photoshop guru and author of nine 
books on Photoshop, Elements, and Illustrator. Matt 
teaches Photoshop and digital photography techniques to 
thousands of people each year. He co-hosts the top-rated 
video podcast Photoshop User TV and also hosts the Adobe 
Photoshop Lightroom Killer Tips and Photoshop Killer Tips 
podcasts. He’s built a massive library of DVDs and online 
training courses, and writes regularly for Photoshop User 
magazine. Matt is an instructor at the world’s premier 
Photoshop event, the Photoshop World Conference & Expo, 
and works in Tampa, Florida, at the National Association of 
Photoshop Professionals.

The composite has to look realistic and if the 
elements don’t fit, the composite will not work.

Another quick scenario could be that 
you’re asked to do a family group picture. The 
only problem is that not all the family will be 
available at the same time. You’re only solution 
will be to take individual images of each family 
group and combine all the images into a 
realistic composite that looks like everybody was 
present when the photograph was taken.

This book is all about selections and details 
to selections. The sample images used in this 
book are available at www.kelbytraining.com/
books/compositing. This book is extremely well 
organized with complete tutorials on each of the 
composites.

Each tutorial includes the primary or 
background image, detailed instruction on how 
to make the selection and finally the finished 
composite. Remember, that background 
could be just as important as the people in the 
composite because you wan the composite to be 
realistic. 

This book shows Matt’s lighting setups, 
incredible Photoshop tips to create certain 
effects. Matt also gives additional terrific tricks 
that most of us probably did not know existed. 
One thing is for sure, if each of us could sit 
down and reproduce each of the tutorials in 
this book like Matt did, then we would have a 
very good idea on how to use Photoshop really 
effectively.

On a side note, I’m still working on the 
first tutorial and it’s not as easy as it looks. Matt 
shows how to make great selections including 
what he refers to as “wispy hair.” Do you want a 
real challenge? 

The cover of this book is one of the 
tutorials. This composite has it all, take time 
and try it. This book is not for the beginner 
but would prove beneficial to someone with 
some Photoshop experience. I personally love 
a challenge and this challenge is one I’m 
enjoying.

Two of the book’s 
tutorials include 
Creating Motion and 
the Basic Composite.
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IRA WILSKER – FREE TV AND MOVIES
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by Ira Wilsker

I was recently helping a disabled Viet Nam veteran with a not so 
unusual problem; he wanted to be able to watch live streaming 
sports events for free. His favorite free streaming live sports website 

now showed a frightening image stating that the domain had been 
seized by ICE (Immigration and Customs Enforcement) for copyright 
infringement. 

Since he was living on his disability income, money was in short 
supply and the various legitimate subscription websites were beyond 
his means. The cost to watch all of his favorite football and basketball 
games that were unavailable on his TV was prohibitive, considering his 
personal circumstances.

I did a search of the free streaming sports websites, and while there 
were several, including NFL.com that displayed videos of past games, 
I was suspicious of those that offered free streaming of live games, as 
ICE, along with the FBI and other law enforcement agencies, have 
been actively seizing domains and servers, and arresting the purveyors 
engaged in intellectual property theft.

Somewhat discouraged, he asked about getting free TV and movies 
on his smart device, a gift from his daughter. I showed him the free 
content on Hulu (hulu.com), and the free full length movies and TV 
shows on YouTube. While lacking the live broadcast TV shows and 
sports, they did have the capability of providing countless hours of 
entertainment without incurring any significant expense.

I later showed him another free streaming service that is explicitly 
for Apple iOS and Android smart devices, including phones and 
tablets, which quickly became his favorite source of free online 
entertainment, TV, and movies; this service is Crackle (crackle.com). 
Crackle is a free download from the iTunes and Play Google stores. 

While not as comprehensive as Hulu or YouTube, Crackle does 
offer a respectable selection of movie and TV titles. The Crackle app 
for both Apple and Android smart devices has been downloaded over 
13 million times. The most recent Android release on October 24, and 
the Apple release on November 3, incorporated several improvements, 
enhancements, as well as better video quality. 

The newest version of Crackle supports HDMI out, if the smart 
device is so equipped, such that it can play on most modern TVs and 
other HDMI equipped devices. There are also free versions of Crackle 

watch free tv and movies 
legally on your smart device

Crackle is a source of 
free streaming 

TV and movies for 
Apple iOS and Android 
smart devices, including 

phones and tablets.
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available for the Nook Tablet, Kindle 
Fire, Windows smart phones, Roku 
boxes, Playstation 3, and Xbox 360 
consoles.

In terms of full length TV shows, 
Crackle has classics such as All in the 
Family with the ubiquitous Archie 
Bunker, Married With Children with 
Chicago’s most famous shoe-man Al 
Bundy, the acclaimed 1967 series of 
an imprisoned former secret agent 
Patrick McGoohan in The Prisoner, 
and dozens of other TV series from 
the U.S. and Japan. 

The clichéd phrase “Dyno-mite” 
can be heard on Good Times, 
while 13 full episodes of Rescue Me 
dramatizes the life of a post 9/11 New 
York Firefighter, both available on 
Crackle. Sanford & Son and The 

Crackle on the iPhone

Three Stooges offer a lot of humor on 
Crackle, but one of the most popular 
TV series, Seinfeld, is also available 
on Crackle. Dana Carvey provides 
Crackle viewers with satirical comedy 
sketches, while dozens of other TV 
series complete the full episode TV 
offerings. 

The TV offerings on Crackle 
are dynamic, in that they frequently 
change with new shoes being added, 
and some shows cycling off Crackle. 
A link on the top of the TV page will 
show the most recently added shows, 
while some other shows indicate 
the date that they will be leaving 
Crackle.

Crackle offers over 300 full 
length, uncut movies 
of all genres. As 
when watching the 
commercial TV 
networks, the movies 
on Crackle are 
periodically interrupted 
for a commercial; it is 
this sponsorship that 
keeps Crackle free 
to the user. While 
many of them are 
lesser known titles, 
many were box office 
successes. 

Movie fans will 
recognize Jacqueline 
Bisset and Robert 
Shaw in the Bermuda 
treasure thriller “The 
Deep,” while the camp 
comedy classic “The 
Gods Must Be Crazy” 
dramatizes the effect a 
Coke bottle can have 
on a primitive society. 

Serpent loving horror aficionados 
may appreciate the nine different 
Godzilla movies available along 
with a companion pair of Mothra 
movies, while zombie followers will 
appreciate the cult classic “Night of 
the Living Dead.” Michael Chiklis, 
currently known for his parts in “The 
Commish,” The Shield,” and “Vegas” 
plays Curly in the 2000 biography 
of The Three Stooges, as seen from 
Moe’s perspective.

Crackle also offers 44 different 
“original series,” many with multiple 
episodes. One humorous but risqué 
original series is “Crash Comedy,” 

Turn to next page

Free versions of Crackle are also 
available for the Nook Tablet, Kindle 
Fire, Windows smart phones, Roku 
boxes, Playstation 3, and Xbox 360 

consoles.
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Ira Wilsker 
hosts “My 
Computer 
Show” a call-
in tech support show on 
KLVI radio, 560AM, from 
4-5 p.m. Mondays, Pacific 
time. The show streams live 
over the net at KLVI.com 
and on the free iHeartRadio 
app. His call-in number is 
800-330-5584.

IRA WILSKER – FREE TV AND MOVIES / RAW EXPLAINED

with Charlie Murphy (Eddie 
Murphy’s brother). The popular 
Las Vegas and television magician 
Penn Jillette has an original series 
of 58 short but snappy satirical 
commentaries on controversial 
subjects in “The Best of Penn 
Says.” Unabashed and often 
politically incorrect, Penn Jillette 
leaves no doubts as to where he 
stands on issues, often injecting 
comedy and satire into his 
analyses.

For those willing to put up 
with the same commercial 
interruptions as they have on the 
network channels on their home 
TV, Crackle is a worthy free app 
for Android, Apple, and Windows 
smart devices, including phones 
and tablets as well Kindle Fire, 
Nook, Roku, Playstation 2 and 
Xbox 360. 

With over 300 full length 
movies, and over a thousand 
episodes from dozens of TV series, 
as well as original content, Crackle 
is definitely worth a try. 

RAW is NOT an abbreviation so writing it as RAW is actually wrong. But JPG is 

an abbreviation. A raw file is literally a raw file. (raw: In its natural state; not yet 

processed or purified.)

There’s a sensor in your camera. When you take a shot, the shutter opens (if it’s a 

DSLR) and the sensor is exposed to the light depending on your shutter speed. Then the 

shutter closes and the sensor collects the information and sends it to the processor to 

process it. That’s where the option comes in use. You can shoot in two formats: raw and 

JPG. When the data comes in the processor, the processor needs to decide on what to 

do to the data. Save it on the memory card the way it is or ‘manipulate’ it. If you set it on 

RAW, the data comes from the sensor to the processor and directly goes on the memory 

card WITHOUT any modification. This is why it’s called raw. It means the photo is NOT 

modified by the camera at all.

But if you set it on JPG, when the data comes from the sensor to the processor, 

the processor has to apply a series of modifications on the image. JPG is an 8-bit 

image. RAW files are 12- and 14-bit images. It means that your sensor captures a lot of 

information then sends it to the processor. The processor then needs to convert the raw 

data to JPG. 

JPG does not support 14-bit images. So the processor literally removes data from 

your image in order to convert it to an 8-bit image and in order to minimize the file size. 

Then it applies the options you have chosen like white balance, sharpness, clarity, HDR, 

vibrance, etc. Then the camera sends the information to your memory card to be saved. 

This is why some say shoot in RAW because you have the very raw and original data. 

There are also lots of advantages to RAW. You can always change the exposure up 

to five stops with RAW files, change the white balance without seeing banding (color 

fringing). Also your RAW files are absolutely indestructible. You can never overwrite a 

RAW file. Also in case of copyright violation, you can prove that you own the copyright by 

bringing the RAW file. The RAW files cannot be produced by computers so if you have a 

RAW file, it means you have taken the photo and therefore you own the copyright.

But don’t forget that there are also disadvantages. RAW files occupy more space on 

your hard drive because they contain a lot of information. An 18MP raw file can be up 

to 25MB but an 18MP JPG file can be about 8MB. Another disadvantage is that many 

devices do not read raw files. (RAW is NOT an extension. Every company has its own 

RAW extension. For example, Canon’s raw extension is CR2 and Nikon’s raw extension 

is NEF.)

But the question is: Do you have to shoot in RAW or JPG? Well, that’s totally up to 

you. If you retouch your images a lot then it’s better to shoot in RAW. If you go out for 

a vacation and want to shoot and then print photos on your PC and upload them on 

Facebook without retouching your images one by one then you should shoot in JPG, 

because you don’t need to convert them. You always have to convert your raw files to 

JPG or any other format to be able to publish them online.

Submitted by Neil Longmuir. Source: Yahoo! Answers at http://yhoo.it/Y5jUIm

what is a RAW file?
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by Linda Gonse

I recently added a second external hard drive to my 
computer system. I use one for backups of InDesign 
files and the other one for Acronis True Image 

system backups. 
As I browsed through the files 

I’d saved to the drives, I ran into 
something peculiar. Both drives had 
folders with names that were long 
strings of random letters. And each 
folder contained one file: mrtstub.
exe at 89KB on the Iomega drive, 
and MPSigStub.exe at 227KB on the 
Seagate drive.

Fearing these might be malware 
or a virus, I quickly did a Google 
search. Interestingly, the search turned up 
conflicting opinions in different forums. Some people 
said it was a virus and highly dangerous, some said the 
folder and file(s) inside were benign, some said the files 
were leftover from when Microsoft Malicious Software 
Removal Tool (MRT) was run and had not been deleted 
automatically, and some said Windows created them. 

Although I only found one file in the folders, other 
people have seen as many as four at one time: mrtstub.
exe, mrt.exe._p, MRT.exe, and $shtdwn$.req.

I found a link to information about the Malicious 
Software Removal Tool at http://support.microsoft.com/
kb/890830#Faq. In particular, it gave instructions on how 
to remove the Malicious Software Removal Tool. 

The Malicious Software Removal Tool does not use an 
installer. Typically, when you run the Malicious Software 
Removal Tool, it creates a randomly named temporary 
directory on the root drive of the computer. This directory 
contains several files, and it includes the Mrtstub.exe file. 
Most of the time, this folder is automatically deleted after 
the tool finishes running or after the next time that you 
start the computer. However, this folder may not always be 
automatically deleted. In these cases, you can manually 
delete this folder, and this has no adverse effect on the 
computer.

holy cow! is this a virus?

I also learned that MRT is not a substitute for a 
resident antivirus for various reasons: 1. MRT only removes 
malware AFTER infection, it doesn’t BLOCK malware 
like an antivirus does; 2. MRT is designed to target a small 

set of malware only, while an antivirus takes care of most 
malware in the wild; and 3. MRT can only detect actively 
running malware — an antivirus can also detect dormant 
malware.

Microsoft’s Knowledge Base (http://support.microsoft.
com/kb/890830) also said a new version of the Microsoft 
Malicious Software Removal Tool is released every month. 
After you download the tool, the tool runs one time to 
check your computer for infection by specific prevalent 
malicious software (including Blaster, Sasser, and 
Mydoom) and helps remove any infection it finds.

This KB article contains information about how you 
can download and run the tool, and what happens when 
the tool finds malicious software on your computer.

Even though I did not intentionally download the 
Removal Tool or run it, I read that Windows Update may 
do that when it downloads automatic updates. Further, it 
uses the largest hard drive on the system to create the temp 
folders; and in my case, the external hard drives are the 
largest with each being 2TB.

The upshot of this was I checked each file’s Properties 
and confirmed Microsoft had signed them. Then I deleted 
the folders and files manually and nothing bad happened. 
In the future, I’ll disconnect the external drives before 
downloading or installing Windows Update.

Folders and files found on external drive.

WINDOWS UPDATE
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Once a digital camera has captured light rays from an object on its photo-electric ele-
ments, a great deal of computer processing has to occur to provide an accurate rendition 
of the shape and colors of the object. 

The color sensitivity of the chip differs from the color sensitivity of the human eye. 
The system also has a narrower dynamic range of sensitivity between the lowest intensity of the light it 
can output, and the highest it can register without being overloaded. 

Colors also vary with the light that shines on them. The human eye automatically corrects for that, 
but the camera has to adapt depending on whether the ambient light is sunny, overcast, incandescent, 
fluorescent, or flash.

Good digital cameras do an astoundingly good job converting the signals received into a natural 
photo. Once it has done its job, most cameras compress the image into a much smaller file for storage 
in the common format, JPEG, that greatly reduces the file size, with a significant loss of data.  It also 
reduces the color depth from 16 bits (or more) as shot to 8 bits, another loss of information. For most 
everyday use the resulting pictures are perfectly acceptable.

If you are not totally satisfied with the picture as the camera produced it, there are a number of 
computer programs that allow you to modify the picture in many ways to fit your purpose. Often that 
involves cropping, brightening or darkening, increasing or decreasing color saturation, and sharpening 

raw editing

 with photoshop elements

Turn to next page

Figure 1 — Inside the RAW editor

Text, photos 
and screenshots 
by Pim Borman

PHOTOGRAPHY – RAW EDITING
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PHOTOGRAPHY – RAW EDITING

of the image. Any number of programs are available for 
that, but I want to concentrate on Photoshop Elements 
(PE), especially version 9 that I have available, the 
lower-cost version of the professional standard bearer, 
Adobe’s Photoshop.

Sometimes the improvements possible with even 
PE are not able to make up for shortcomings of the 
photo. The dynamic range, i.e. the difference between 
the brightest and the darkest part of the image may be 
too great, or the color of the ambient light is wrong. 

There are ways to improve such shortcomings to 
some extent in the editor, but because so much of the 
original details of the picture have already been dis-
carded by the camera, the options are limited.

Some of the more expensive cameras, even pocket-
sized ones like my Canon Powershot S95, optionally 
save the image with a minimum of editing and without 
discarding any details, including the full color depth 
of 16 bits, versus the 8-bit depth of JPEG images. Such 
images are generally referred to as RAW files. 

RAW is not a standard format and may vary be-
tween makes, and even individual models, of digital 
cameras. RAW pix taken with my older Canon DSLR 
camera worked fine with PE9, but pix taken with my 
newer Canon S95 in RAW format did not work at first. 
I had to download a newer version of the RAW editor 
from the Acrobat web site. RAW files may have differ-
ent extensions, depending on the make of camera. My 

Canon S95 uses the extension CR2. RAW files loaded 
into the PE Editor open in a special RAW window (Fig-
ure 1). Editing in the RAW editor replaces the precon-
ditioning normally done by the camera. After the RAW 
editing is done, the picture is transferred to the regular 
editor for final optimization. 

At the top of the RAW editor window are mostly fa-
miliar tools. The eye dropper, when touched on a white 
or neutral gray object, corrects the ambient color of the 
image. The angle icon allows straightening an image if 
the camera was tilted. The rectangle tool allows crop-
ping the picture. It should be noted that none of the 
changes made in the RAW editor affect the original 
image file. Changes are listed in a separate file and 
combined with the original when the picture is subse-
quently opened in the regular PE Editor.

The menu column at the right is where most of the 
work takes place. At the top is a histogram that shows the 
range of color intensity that is within the limits of the elec-
tronic chip. Anything to the left is too low to be registered, 
anything to the right is overloading the electronics. Most 
of the tools are intended to change the histogram so that 
all the colors are evenly spread out, as much as possible, 
without clipping.

First you want to decide on the lighting color (tempera-
Turn to next page

Figure 2 — Color optimized in RAW editor

Figure 3 — Using Detail In RAW editor
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ture) of the image, using 
the options under the 
White Balance menu, 
using the aforemen-
tioned eyedropper, or 
manually moving the 
two color sliders. 

The picture shown is 
severely underexposed, 
as shown by the clip-
ping on the left side 
of the histogram. The 
Exposure slider helps to 
correct that. If some of 
the colors slip over the 
right side of the histo-
gram, they can be recovered with the 
Recovery slider. 

The left side of the histogram can 
also be shifted to the right with the 
Fill Light slider. Notice that some of 
the numerical parameters are already 
preset in anticipation of expected cor-
rections needed when the file 
is loaded. Those are the ones 
used by the camera by default 
in processing pictures.

Figure 2 shows the result 
of optimizing the image for 
color. Increasing the exposure 
and sharply increasing fill light 
made it necessary to reduce the 
overall Brightness. Contrast was 
reduced to bring up the left side 
of the histogram. Increasing the 
Clarity and Vibrance restored 
much of the contrast and color. 
The drastic changes made to 
this image were necessary be-
cause of its poor initial quality. 

After the pre-processing 
all image data originally pres-
ent in the RAW file have been 
retained and made available for 
further editing. 

PHOTOGRAPHY – RAW EDITING

Notice that the data now cover 
most of the width of the histogram. 
A small amount of clipping on the 
left, originating in the heart of the 
flower, is acceptable since it won’t be 
noticeable.

To sharpen the image, we 
change to a different page of 
the RAW editor, by clicking 
on the small icon with the 
two rectangles at the top of 
the menu. The menu heading 
changes from Basic to Detail 
and a new set of parameters 
shows up (Figure 3). 

First of all, increase the 
size of the image to 100% 
so you can see what you are 
doing. Make sure the screen 
shows a significant part of the 
image to be sharpened. In 
this case I zoomed in on the 

heart of the flower.
The first three sliders are intuitive, 

but the Masking slider needs expla-
nation. Sharpening the image with 

Figure 4 — In Photoshop Elements editor

Turn to next page

Figure 5 — The Final Result
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PHOTOGRAPHY – RAW EDITING

•  If you only have pictures in JPEG format, you can still 
load them into the RAW Editor by using “Open as...”and 
specifying the RAW format from the submenu. That way you 
still have access to the advanced tools of the RAW editor, 
although you’ll have less of an image to work with.

•  I save all my photos by default in both RAW and 
large JPEG formats, using that option with my camera. The 
file sizes may be large, but even with a modest 2GB chip I 
can store many photos before they must be offloaded to the 
computer.

•  RAW editing can usually be done in a minute or so, 
once you get the hang of it. The photo used in this article 
was intentionally poorly shot to demonstrate the power of 
extreme RAW editing. With properly exposed photos, RAW 
corrections are minimal and quickly done. The RAW option 
is not available if you use the camera in automatic mode.

•  When viewing a photo on the camera screen, with 
many cameras there is an option to see technical details, 
including the histogram. If the histogram looks very one-
sided, you may be able to change the camera settings and 
shoot the picture again, if possible. 

the Amount slider tends to cause 
mottling to show up, especially in 
the darker parts of the image. 

The Masking slider masks the 
smooth portions of the image but 
not the outlines. To use the slider, 
hold down the Alt key while moving 
the slider to the right. The initially 
blank screen gradually darkens 
until only the outlines are barely 
visible. Let go of the Alt key and use 
the Amount slider to only sharpen 
the outlines, without affecting the 
smooth portions.

Even so, some mottling will 
probably show up when you apply 
a healthy dose of sharpening. The 
Luminance slider is designed to 
reduce the mottling. Don’t overuse 
it, or your picture will start looking 
pasty. Sometimes sharpening also 
introduces colored mottling. The 
color slider can reduce that.

By now you have done as much 
as you can in the RAW editor and 
you’ll finish the job in the regular 
editor. Transfer the image by click-
ing on Open at the bottom right. 
The RAW editor closes, and the 
picture appears in the regular PE 
editor (Figure 4). 

It may still be in 16-bit format, 
if it was an original RAW image, 
and it needs to be reduced to 8 bits 
at this point. Click on Image ... 
Mode…and select 8-bits.

You now have a head start in the 
PE Editor for adjusting whatever 
else may be needed. The last step 
should be resizing the image to suit 
your needs. Remember that the 
original RAW file was not changed, 
so you can always go back later and 
do it over again, if needed. Figure 5 
shows my final result.

Copyright ©2013 Willem F. Borman

tips for raw editing



ORANGE COUNTY PC USERS GROUP — MARCH 201322

After 19 years in San Diego, the Southwest Technology & 
Computer Conference has moved to Kellogg West Conference 
Center & Hotel at Cal Poly Pomona for the 2013 conference to 

be held June 21-23. 
Kellogg West Conference Center & Hotel is uniquely located on a 

wooded hilltop overlooking cereal magnate W.K. Kellogg’s former ranch 
estate.

The $85 Early Bird registration fee covers all meals (Friday dinner, 
Saturday breakfast, lunch and dinner and Sunday breakfast) and 
includes all workshops, Expo, Welcome Bag, and more.

The room rate in the recently renovated two-story hotel is $89 per 
night single, $95 double, $105 for four, and features many amenities.

In addition, there is free parking and free Wi-Fi in the Conference 
Center and Hotel rooms. For attendees who fly in, there is a free shuttle 
from Ontario International Airport.

The Kellogg West Conference Center & Hotel is located at 3801 W. 
Temple Avenue, Pomona, CA 91768. Check here for directions and local 
attractions, http://www.kelloggwest.org/kw-directions.aspx

For conference details and registration information go to http://www.
theswcc.org/registration/registration.htm

southwest technology & computer conference
has new location for 2013
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INTERNET

interesting finds
by Steve Costello, BRCS

In the course of going through the more than 200 
news feeds in my Google Reader, I often run across 

things that I think might be of interest to other user 
group members. The following are some items I found 
interesting during the month of October 2012. (Long 
URLs shortened with the Google URL shortener http://
goo.gl/ )
•  The Best Three Public Domain Clipart Galleries
 —http://goo.gl/DGNMq
•  HTG Explains: How Antivirus Software Works —
http://goo.gl/Yjp38
•  Why I bought my wife a Mac — 
http://goo.gl/FDzmM
•  How To Get Free Movies Online - Legally —
http://goo.gl/jc8Nw
•  Secrets for successfully narrating a presentation —
http://goo.gl/USl4m

free ocr service

Free-OCR.com is a free online OCR (Optical 
Character Recognition) tool. Use this service to 

extract text from any image you supply. The service is 
free, no registration necessary. They also do not need 
your email address. Just upload your image files. Free-
OCR takes either a JPG, GIF, TIFF, BMP or PDF (only 
first page). The only restriction is that the images must 
not be larger than 2MB, no wider or higher than 5000 
pixels and there is a limit of 10 image uploads per hour. 

Source: HHICC newsletter, Island Computing 

unusual sights
•  intelliPaper®. Paper marries digital technology and 
the wireless USB thumb drive — http://bit.ly/YG1qPP
•  Hummingbird Nest Cam — http://phoebeallens.com/
•  Moving Art — http://bit.ly/XH46cO

•  The 10 Weirdest Animal Discoveries of 2012 — http://
www.livescience.com/25707-10-weirdest-animal-
discoveries.html
•  Animal Babies, cuter than cute! http://pinterest.com/
maureenjordan/animals/
•  Live! From the Eagle’s Nest — http://eaglecam.dnr.
state.mn.us/

Submitted by Linda Gonse

not science fiction!
The smart phone and your health — http://nbcnews.to/
XDmpCz

Submitted by Tony Lake

look at what we found 
on the internet!
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 USER GROUP ANNOUNCEMENTS / NEWS

thank you  
2012 vendors!

Thank you Acoustica 
Software, At Home, iolo, 

Memorex, nik Software, Smith-
Micro, Office Depot, and User 
Group Relations for generously 
donating your products to our 
2012 fundraising raffle! 

secret keyword
raffle resumes

Anew Secret Keyword Raffle 
begins this month. There 

are two prizes: A 48-sleeve CD 
Wallet, and a Home Ranger 
Shoulder Pulley. The keyword 
is hidden in the newsletter or 
somewhere on the website at 
www.orcopug.org. Find the key-
word and be ready to say what it 
is if your name is called and take 
home the prizes! 

 thank you
newsletter contributors!

Carl Westberg, Charlie Moore, Frank 
Bollinger, HHICC Island Computing, Ira 
Wilsker, Judy Taylour, Leo Notenboom, 
Linda Gonse, Mike Lyons, Neil Longmuir, 
Pamela Tabak,  Pim Borman, Ron 
Hirsch, Sharon Parq Associates, Steve 
Costello, Ted Wirtz, Tim O’Reilly, Tony 
Lake, Wes Taylor

april deadline
march 23

meet the New CISPA.  
same as the Old CISPA.

Last year, thanks to a public outcry, the effort to pass overreaching 
cybersecurity legislation stalled in the Senate. Now supporters have 

reintroduced the House version of that legislation — the Cyber Intelligence 
Sharing and Protection Act (CISPA).

The “new” version is in fact identical to the original CISPA — and poses 
the same threat to our digital civil liberties.

If CISPA becomes law, it will be a major blow to our online privacy. But 
more than that, CISPA’s passage would have a chilling effect on our freedom to 
connect online. We won’t feel as free to state unpopular opinions, or to speak 
truth to power, if we know that Big Brother could get a feed of everything we 
say and do.

This is not what the free and open Internet is about. We must tell Congress: 
Vote NO on CISPA and bury this bill for good. Sign the petition to our 
Congressional lawmakers at http://bit.ly/ZG8eM8 — The FreePress Action 
Fund

this isn’t summer camp

The percentage of households with broadband access in the United States 
trails behind many other countries. Those Americans who do have 

internet access generally pay far more for far less service than our counterparts 
in other parts of the world.

It is a national embarrassment that 
kids in this country living in low-income 
and rural communities have to rely on fast 
food chains like McDonald’s because they 
can’t get affordable internet access in their 
homes.

Some would like to think that 
America’s broadband is doing just fine, 
and that it’s improving slowly but surely. 
But as our Senior Vice President Harold 
Feld has pointed out, “this isn’t summer camp. This is our digital future.”

To add insult to injury, many of the underpowered, overpriced connections 
available to you come with data caps. These caps are not only confusing to 
consumers, but lend themselves to unfair and anti-competitive behavior by 
internet service providers.

We are fighting everyday to make sure that Americans have access to real, 
reasonably priced internet access. As a first step, sign the petition at http://bit.
ly/WvnzN8 asking the FCC to investigate the data caps that are reducing 
the promise of broadband access for all. — The Public Knowledge Team
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MEMBERS’ PAGE

email
addresses

Bollinger, Frank
  frbollinger@earthlink.net
Boutwell, Lloyd
  Boutwell65@yahoo.com
Gonse, Linda
  editor@orcopug.org
Jackson, Walter
  wvjaxn@charter.net
Kaump, LeRoy
  leroy_kaump@hotmail.com
Klees, Larry
  larryklees@yahoo.com
Loehr, Lothar
  lothar@orcopug.org
Lyons, Mike
  mike@orcopug.org
Moore, Charlie
  charlie@orcopug.org
Musser, Dave
  dmusser@worldnet.att.net

Meetings are the second Tuesday of every month. See www.orcopug.org for more information. 

Last Name				    First Name				    Nickname

Mailing Address						      City				    State      Zip

Home Phone (        )		      Work Phone (        )			   E-mail Address
  
Areas of Interest/Comments

membership application 	     Renewal*New Member

Expired members are not eligible to win raffle prizes or to access the Members’ Only web page. 

Make checks payable to: ORCOPUG — Dues are $25 per year
ORCOPUG, P.O. BOX 716, Brea, California 92822–0716

time
       for renewal?

Give Your Computer A Gift…become a member of ORCOPUG! 

For about $2 a month you can be a member of our user group!

MARCH 1	 Frank Bollinger

	 Ken Sineri

APRIL 1	 Lothar Loehr	

MAY 1	 Lloyd Boutwell

JULY 1	 Gary Covington III

	 Walter Jackson

submitted by Charlie Moore

BRING USED INKJET 
PRINTER CARTRIDGES 

to meetings for our ongoing fund-
raising project: Hewlett Packard, 
Canon (BC-02, BC-05, BC-20 or 
BX-3), Lexmark, Dell, Compaq, 
Kodak, Samsung, Sharp; or any 
laser printer cartridge. 

check out our website
orcopug.org

no february 
raffle results

There are no February meet-
ing raffle results. Due to a 

lack of time following the pro-
gram, the raffle was not held.

Westberg, Carl
  carl@orcopug.org
Wirtz, Ted
  twirtz@pacbell.net
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member of the association of 
personal computer user groups

•  Product & “How To”demos
•  Free raffles and magazines
•  Help from other members
•  Newsletter and web site
•  Special offers & discounts
•  Monthly meetings
•  Affiliation with worldwide group

benefits of 

      User Group Membership

computer users helping 
computer users

• program of the month • newsletters • tech & help  
links • pdf & on-site search  • map • online review 
form • help & tips  • computer shows  • contact info  
• membership application • Members’ Only! page 

our website has everything you need!

www.orcopug.org

User groups represent the spirit of the 
frontier, a community getting together to 

do things that no individual ought to have 
to do alone. The pioneers of the American 
west got together for barn raisings, cattle 
roundups, and the occasional party. The 
pioneers of new technology get together for 
installfests, new user training and support, 
and just plain fun. Being part of a user 
group is the best way to get more out of 
your computer, and lets you make friends 
while you’re at it.

Tim O’Reilly, President
O’Reilly Media

where are the meetings, when are they held?

R      egular meetings are held the second Tuesday 
      of the month at 6 p.m. at Coco’s Bakery 
Restaurant, 1011 North Harbor Blvd., Fullerton, 
CA. Meetings are free and the public is welcome!

next meeting: Tuesday, March 12, 6 p.m. to 9 p.m. — Coco’s Bakery Restaurant

Go to www.orcopug.org for the Yahoo! location map,
or check the Google map at http://bit.ly/J9Kcm3

Planning meetings are held the second Wednesday 
after the regular meeting every month at 6:30 p.m. at 
Carl’s Jr., 3240 Yorba Linda Boulevard, Fullerton, CA 
92831. All members are welcome to attend planning 
meetings! 


